
MANAGING YOUR INVENTORY
The Inventory is very many things. It is your own, unique collection of 
Second Life items ranging from complete houses and spaceships to socks 
and bubble gum. It is also a pet that grows into a monster. If anyone 
ever wanted clear proof that humans are insanely acquisitive by nature, 
the SL Inventory is that proof. A long time ago, when Second Life was 
in its infancy, there was a cap on the number of items you could have in 
your Inventory: 255. Now that there’s no limit, most SL denizens quickly 
accumulate many thousands of objects. It’s easy to let your Inventory get 
out of control, and once it does, more and more of your new life will be 
spent looking for stuff instead of enjoying yourself. Sound familiar?

If you’re new to Second Life and are frowning with disbelief, consider 
this: SL is a world in which you carry everything you own—house, car, 
50 wardrobes of clothing, and so on—on your person. And if you’re also 
running a business, and/or constantly creating new unique items... let’s 
just say keeping track of all the items in your Inventory isn’t easy. It’s in 
your best interest to have as little as possible (for most SL denizens, “as 
little as possible” means fewer than 5,000 items).

In this chapter, I’ll take a close look at the SL Inventory and discuss 
how to manage it effectively. You’ll fi nd out how to organize Inventory 
folders, and keep them under control even though they’re multiplying like 
rabbits. You’ll also learn how to store stuff in locations other than your 
Inventory. In short, this chapter is an Inventory master plan that should 
make your new existence more carefree and enjoyable.
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THE INVENTORY VS .THE LIBRARY

When you begin Second Life, your Inventory seems to be an underdeveloped 
offspring of the Library. The few folders in the Inventory correspond to Library 
folders with the same names, but they are mostly empty, or at best have just 
part of their Library equivalents’ content. There is no warning of your Inventory’s 
imminent mutation into something resembling a garage sale thrown by a freshly 
bankrupted and slightly deranged millionaire. This moment of peace is ideal for 
taking a look at the important differences between the Inventory and the Library.

The Library, as you might guess, is public: it’s shared by everyone. Your 
Inventory is your own, and no one else’s. Of course, initially your Inventory is 
identical to everyone else’s, but it quickly becomes as unique as the choices you 
make in Second Life.

You cannot delete or modify the contents of your Library, but you can do 
as you please with the Inventory (there are exceptions, discussed later in this 
chapter). Note that when you use a Library item, it is automatically copied into the 
appropriate folder in your Inventory. These copies are prime candidates for the 
trash can during your periodical Inventory cleanouts. Your number-one Inventory-
management rule is to never keep two copies of an item in the same Inventory. 
Stick to this rule from the start, and you’ll save yourself lots of time. Otherwise you 
might spend most of your new existence looking for stuff hidden among thousands 
of other items!

Of course, no matter how hard you try, you’ll always have a ton of stuff in your 
Inventory. As you know from Chapter 3, your Inventory will start to grow almost 
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PARTING WITH YOUR CREATIONS

Don’t get overly sentimental about your own creations. Don’t keep 
everything you’ve made just because you made it. The very next object 
you make will be exclusively yours too, and most likely better than what 
you created earlier. If you want a private museum of your work, store it 
outside your Inventory.
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as soon as you 
arrive on Orientation 
Island—that’s even 
before you get to Help 
Island and begin fi lling 
your Inventory with 
all the cool freebie 
items available there. 
If you don’t monitor 
your Inventory from 
the very start, you’ll 
be overwhelmed 
before you know it. An 
important Inventory-
management rule is 
to organize Inventory 
contents right at the 
start of your new 
existence (Figure 
6.1).

One of the fi rst things you should put into your Inventory is some order. Trash 
unwanted items and reorganize your Inventory before you depart Help Island for the 
SL mainland. It’s best to get a handle on things right away!

Figure 6.1: To trash or to stash? That’s the big question you’ll 
be asking yourself again and again in Second Life.
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ORGANIZING YOUR INVENTORY

N
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T
E ADDITIONAL INFO:

KEEPING YOUR INVENTORY UNDER CONTROL

When you open your Inventory, a line at the very top will tell you how 
many items it contains. If you do not work on keeping the Inventory 
under control with beady-eyed zeal, the number displayed will reach four 
fi gures before you leave Help Island and will grow to fi ve fi gures soon 
after you arrive on the mainland.
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First of all, take a good look at your existing Inventory folders. You’ll notice some of 
them feature little icons. Any Inventory folders marked with icons cannot be moved, 
deleted, or even renamed; they’re part of the Inventory setup. So, to begin with, move 
all your unmarked folders inside the icon-marked folders. Naturally, use logic: put 
clothing items into the Clothing folder, textures into the Textures folder, animations into 
Animations, hair into Body Parts, and so on.

Once you’ve done 
that, open each folder 
in turn, and organize 
its contents. For 
example, you might 
want to create a Hair 
subfolder within the 
Body Parts folder for 
all the different hair 
types and styles you’ll 
have by the time you 
leave Help Island.

Clothing also 
merits special 
attention, as always. 
It’s a good idea to 
group clothing items 
into outfi ts, creating 
a subfolder for each 
complete outfi t. Any 
remaining clothing 
items can be organized the way you organize things in real life, except that you’ll be 
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FOLDER-MANAGEMENT OPTIONS
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Figure 6.2: Keep the number of folders in your Inventory as 
low as possible, but not at the expense of your comfort.

Double-click to open and close folders. Right-click on a folder to open a 
menu that shows a list of folder-management options. If the menu that 
appears is blank, the selected folder is part of the Inventory setup and 
cannot be manipulated in any way.
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using folders instead of closets and drawers for your shirts, pants, socks, etc. While 
you’re at it, ask yourself whether you’ll really, really wear a particular item. If you 
proceed on the “what I own can’t hurt me” principle, you’ll quickly fi nd out that indeed 
it can. Don’t forget to check out the Inventory-management advice from longtime SL 
residents in the sidebar.

The bonus of keeping a lean, well-organized Inventory (Figure 6.2) is extra time. 
You won’t have to wait long for your Inventory to load, and you’ll fi nd stuff much 
faster. You’ll be doing a bit of good for the SL community, too: huge Inventories cause 
slowdowns for everyone in the SL world.

CREATING AND USING STORAGE PRIMS
You can also realize your dream of a lean, mean Inventory by putting Inventory items 
inside prims. This has its advantages and disadvantages. You can remove the storage 

“Subfolders are your friend. Making your own folders to keep ‘important’ 
stuff and your ‘single copy’ objects really helps keep things organized.”

—DolphPun Somme

“I think of it the same way I think of organizing my hard drive. General 
folder, more specifi c subfolder, specifi c subfolders…i.e., clothing, casual, 
shoes. Or building materials, textures, exterior textures, brick. I spend 
around 30 minutes of every session cleaning up, naming, and moving 
around Inventory items.

“Something I just discovered last night in terms of clothing: activate 
the debug menu (ctrl-alt-D) and then go to the bottom of it and select 
Clothing. A list of everything you have that's defi ned by the system as 
clothing appears and can be put on/removed via the list. It’s a good way 
to fi nd the undershirt under the shirt under the jacket that you think 
you might have on.”

—Rakkasa Lewellen
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MANAGING INVENTORY CONTENTS
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prim from your Inventory and store it elsewhere; on the other hand, you cannot store 
folders inside a prim. If you attempt to move a folder into a prim, you’ll move the 
folder’s contents but not the folder itself. Upon opening the storage prim, you’ll see all 
of the folder’s items in exactly the same order as they were in the folder.

Another snag is that you won’t see what’s inside the storage prim until you open 
it. Give your storage prims names that will help you remember their contents. For 
example, if you’re going to store an outfi t consisting of a number of items, you might 
want to name the prim after the outfi t—that’s the way most SL old-timers handle 
things.

Here’s the procedure for creating and using a storage prim:

1.  Make sure you’re on land that allows building: the top menu bar will show the 
No Build icon if it’s not allowed.

2.  Create a prim—any prim. Size and shape don’t matter; you’re free to make it 
anything you like. My personal favorites are mysterious black cubes, and steel-
plate cylinders. They simply look cool.

3.  Name the prim right away (under the General tab in the Edit menu). As 
mentioned earlier, give it a name that’s illustrative of its contents.

4.  Open your Inventory, and right-click on the item or items you want to put inside the 
prim to check their properties. As a rule, don’t mix items that can be copied with 
items that cannot. Create a separate storage prim (or folder, if you don’t want to 
mess with prims) for noncopyable items. The prim containing no-copy items will be 
particularly valuable, so keep it in your avatar’s Inventory (Figure 6.3).

5.  Click and drag the folder/items from your Inventory and onto the storage 
prim. You’ll see the cursor change to a little white folder marked with a plus 
sign; release the mouse button to drop the transferred item into the prim. 
Occasionally, you may run into trouble when transferring entire folders: you’ll 
see the universal red circle with a slash through it to indicate your action is 
forbidden. Try opening the affected folder and transferring the items within one 
by one; that’s how they’ll be stored inside the prim, anyway.

6.  Right-click on the prim to bring up the pie menu. You should see an active Open 
option. Click on it to view prim contents, and note the buttons at the bottom 
of the Contents menu that let you instantly copy all stored items into your 
Inventory (assuming they’re replicable). You may also view the prim’s contents 
by choosing Edit from the pie menu and selecting the Contents tab.
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7.  Decide 
whether you 
want to keep 
the storage 
prim’s contents 
private: select 
the appropriate 
check boxes in 
the Edit menu 
(General tab).

As you can see, 
storing items in prims 
is a simple process, 
and very popular 
among SL citizens. 
However, there are 
also more-elegant 
solutions, such as 
special security 
boxes. If your building 
and scripting abilities 
don’t allow for making 
one of those, you can purchase them at stores such as the THiNC store mentioned in 
the “Storing Inventory Contents” sidebar later in this chapter. They’re not expensive—
to give you an idea of what you get for what money, here is a selection of THiNC 
offerings and their prices at the time of writing:

  Inventory Box Organizer—L$215 (copyable). This stores all types of items, 
from clothes to landmarks, with the exception of scripts. It allows you to 
browse through contents and quickly locate the items you want. The name you 
give to the organizer is displayed on the box, which lets you store numerous 
boxes inside one main organizer without identifi cation problems. This organizer 
has full privacy and security features; only the owner can access functions. 
Sleep Mode changes the organizer’s appearance: buttons and text disappear, 
and it looks like a standard trunk.

  Multi-Texture Organizer—L$650 (copyable). This organizer lets you store, 
browse, and manage stored textures through a nine-panel display. All functions 
are owner-accessed only. Privacy and security features include Sleep Mode. A 
cheaper model, the Single Texture Organizer for L$115 (copyable), provides 
the same functions but features a single-panel display for browsing and texture 
management.

Figure 6.3: Twenty pairs of pants, ten pairs of shoes, a dozen 
shirts—all packed uncreased into a tiny metal cylinder! Only in 
Second Life.
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  THiNC Book 2.0—L$75 (single version). This versatile book can be used as 
a photo album, a novel, or a catalog. It comes with a full set of animations and 
sound effects (book opening, book closing, pages being turned). Transferable 
and fully modifi able by the owner.

  THiNC Printing Press—L$895 (single version). This lets you produce 
unlimited, exact copies of the THiNC Book 2.0 for unlimited distribution. Each 
published book has copy and transfer rights modifi able by the owner (publisher).

The THiNC store is one of many that specialize in offering great Inventory-
management aids. There is a wide variety on offer, and who wants to keep SL 
snapshots in a boring folder named Photo Album when they can be stored and viewed 
on a copyable TV set? Consider spending a few hundred Linden bucks on Inventory-
management tools; you’ll likely fi nd they’re your best investment.
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“Use the search box at the top of the Inventory panel to quickly locate 
Inventory items by associated keywords. For example, typing ‘WORN’ 
into the search box returns a list of all the items your avatar is currently 
wearing, along with their Inventory locations. The keyword you enter into 
the search box acts as a fi lter regardless of whether it’s an item name 
or property. For instance, if you enter ‘NO MODIFY’ you’ll see a list of all 
Inventory items that cannot be modifi ed, while entering ‘HAIR’ will display a 
list of all the hair in your Inventory.

“To run a check on Inventory items acquired [since] your last online session, 
select the Recent Items tab on the Inventory panel. Note also that you can 
sort all Inventory folders and items by name or by date of acquisition.

“When you want to rearrange your Inventory, select New Window from 
the File menu to open a mirror Inventory panel—it’s easier to keep track 
of what you’re doing when you have two identical Inventory panels side by 
side. Drag the Inventory items and folders you want to move to their new 
locations in the mirror Inventory panel.

“Also, there are online resources you can use to improve your Inventory-
management skills. Visit http://secondlife.com/knowledgebase/
article.php?id=074 for tips on Inventory fi lters, and read Willow 

RESIDENTS SPEAK:

INVENTORY MANAGEMENT
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Real life abounds in paradoxes, and so does Second Life. You’ve just learned that 
you should strive to keep your Inventory as small as possible; now you’ll fi nd out why 
you should have two Inventories: sadly, no technology is perfect, and occasionally 
Inventories become corrupted. To put it bluntly, you can lose everything you own in 
Second Life because of a few rogue electrons somewhere, just like you can lose 
everything you own in real life because the weather and/or earthquake gods have a 
hangover.

After making sure your Inventory contains absolutely no trash (remember to empty 
that trash can regularly!), copy it. You can copy everything except for nonreplicable 
items into a single prim and store it on your property, rented or owned.

‘Queen of Inventories’ Zander's tutorial at http://64.233.167.104/
search?q=cache:CJ6dK8Vv5AEJ:pixelpinuponline.com/features/
inventory-a-mess-never-fear-willow-is-here+willow+zander+in
ventory&hl=en&ct=clnk&cd=1. It’s widely recognized as the Inventory-
management bible among SL residents.”

—Torley Linden

N
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T
E FROM LINDEN LAB:

TRANSFERRING FOLDERS TO AN OBJECT’S INVENTORY

When a folder is dropped into the inventory of an object, all of the 
folder's items are transferred individually to the object. Note that 
scripts transferred using this process are deactivated (each script must 
be dragged separately, or selected using Shift and/or Control-clicking 
and dragged as a mass selection). A UUID number is automatically 
attached to items without unique names (the UUID, or Universal Unique 
Identifi er, is the 128-bit unique number assigned to every asset in 
Second Life).
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MANAGING MULTIPLE INVENTORIES
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If you have a free 
account that does 
not allow you to own 
land, try renting. You 
should be able to 
negotiate rental of a 
prim storage lot for 
less than L$250 a 
week, and probably 
less than L$100. 
There’s also another 
solution—not very 
elegant, but effective. 
This is to create an 
alternate avatar, and 
back up your Inventory 
by copying it to the 
alternate avatar’s.

CREATING AN ALTER EGO FOR INVENTORY BACKUP
To begin with, you must create a new character. The obvious route is to open a new 
free account and create a mule without land-owning privileges. However, remember it 
may actually be worth your while to create a second Premium account. As explained 
in Chapter 2, this gives you two shots at buying First Land at the rock-bottom price 
of one Linden dollar per square meter. You can buy two First Land parcels side by 
side and join them to create a bigger parcel, or you can sell one parcel and keep the 
other—as noted in Chapter 2, practically all First Land can be sold immediately at a 
healthy profi t.

N
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T
E ADDITIONAL INFO:

THE 16-SQUARE-METER PLOT

There are always plenty of tiny 16-square-meter plots available for sale or 
rental; they let you store up to three prims (Figure 6.4). How much stuff 
you store within those prims is, of course, your private business.

Figure 6.4: A 16-square-meter plot is perfect for storing prims.
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Having created an alter ego, move it to the mainland and transfer all the replicable 
items you really, really don’t want to lose to the alternate avatar’s Inventory. Of course, 
you can do it via a storage prim—just make sure your alternate avatar has the rights 
to open the prim and to copy its contents into its own Inventory! However, you can also 
effect a direct Inventory-to-Inventory folder and item transfer using the Search function:

1.  Click the Search button on the main game menu, and select the People tab.

2.  Type in your alternate character’s name, and make sure the Online box is not 
checked.

3.  Click the Search button next to the name you typed in. This opens your 
alternate character’s Profi le panel on its default 2nd Life tab. You’ll see a Give 
Item slot near the bottom of the panel.

4.  Drag and drop Inventory folders and/or items into the slot, one by one. A blue 
info panel will tell you about your alter ego’s offl ine status and state that the 
items will be saved for delivery.

5.  When you log 
on as your 
alter ego, you’ll 
see a blue info 
panel asking 
whether you 
want to accept 
the items; and 
after you accept 
them, you’ll fi nd 
them in your 
Inventory (Figure 
6.5). Note 
that, at the 
time of writing, 
transferring 
an Inventory 
item via the 
Profi le panel to 
someone who 
is online isn’t 
confi rmed until 
the recipient accepts delivery.

Figure 6.5: If another SL denizen gives you something while you’re 
offl ine, you’ll get a message as soon as you return to Second Life.
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“It is possible to put items in prim boxes to reduce Inventory clutter, and 
reduce the complexity of your Inventory.

“Once you have made one of these storage collections, you can store one 
copy of the box in-world, or you can give a copy to a friend (or an alt) to 
keep in their inventory in case yours gets corrupted. I highly advise doing 
that, as inventories are just collections of data records in the asset server 
database, and Linden Lab is not responsible for restoring lost content!

“The downside is, you can’t search Inventory to fi nd any of those items 
unless you look inside the contents of each box and see what’s there! Ever 
open a box that’s been stored for years? Ever been surprised that you even 
owned half the stuff in there? You can repeat this as much as needed. 
Have a prim called ZZZ—The Attic and store all the other boxes in that.

“Warning: If you want to store no-copy stuff this way, such as purchased 
clothes that you don't wear very often, make sure the storage box has 
been named before you put the fi rst no-copy item into the box! I advise 
keeping the no-copy stored items separate from the copy-permitted ones, 
because while there is a no-copy item in a storage box, the entire box’s 
contents can't be duplicated.”

—Ceera Murakami

“I will tell you my secret to my perfect Inventory system. First of all, every 
matching outfi t gets its own prim box, and is labeled according to what 
that outfi t is. Then I put the prim boxes into the copyable, no-transfer 
organizer boxes from THiNC. Why are the THiNC boxes so wonderful? 
They have arrows on them that let you browse through the contents, and 
quickly retrieve what you want.

“My 4,500+ textures are organized by type. The THiNC copyable, no-
transfer machines let me pull out a fresh one for, say, castle-type textures 
and store all my castle textures in there. All my tile textures go into 
another one, and so on.

“My entire Inventory is organized this way, and it is mainly because of the 
Library that my Inventory is at 2,000—yes, you read it right; my Inventory 
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In summary, getting a fi rm grip on your Inventory right from the start is a major—some 
might say the major—factor in enjoying your new life to the max. It frees you from the 
drudgery affl icting real life, in which the tyranny of material things makes people go postal. 
To maximize your chances of freedom and eternal happiness in Second Life, here are the 
fi ve main Inventory-management points:

1.  Organize Inventory contents before you leave Help Island for the mainland, and 
don’t keep two copies of the same, replicable item in your Inventory. As discussed 
earlier on in this chapter, this includes all the items in your Library folder.

2.  The subfolders are your friends. Don’t keep miscellaneous items rattling around in 
the main Inventory folders.

3.  Don’t carry stuff you aren’t likely to use in the near future. Trash everything you 
probably won’t use, and store seldom-used items inside storage prims. Store 
the storage prims outside your Inventory, except for the single prim containing 
nonreplicable items.

4.  Make a backup copy of your Inventory. Put it in a storage prim outside your 
Inventory, or copy folders and items into an alternate character’s inventory.

5.  Make a point of emptying the trash can at the conclusion of every SL session. The 
items in the trash can take up as much space as they did in their original folders. 
There always should be some trash to delete at the conclusion of a session; if 
there isn’t, you’re either an Inventory-management genius, or rather hopeless.

Accumulating enough of your own stuff to fi ll a large museum is easier than you 
may think. A large part of SL activity revolves around creating new in-world objects—not 
surprising, considering that the SL world as such has been mostly built by SL denizens. 
Accordingly, the next chapter discusses building new things.

is at 2k and I grumble over it constantly. I try to keep it as low as possible 
so I do not get any Inventory lag.”

—Tyci Kenzo
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